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SECURITY INSTRUCTIONS

Please read carefully these safety instructions. 
1. Keep this User Manual for future reference.
2. Power connectors must stay accessible for disconnection and power cord must be

placed  where  people  will  not  step  or  stumble.  Unplug  the  equipment  from the
AC/DC before cleaning. 

3. The equipment must not be exposed to water and water containers must not be
placed over it. Do not use liquid or sprayed detergent for cleaning. Do not expose
this equipment to humid areas. 

4. Do not place naked flames near the equipment. 
5. Install this equipment in a safe surface. If the equipment is not in a safe surface, it

may fall and be damaged. 
6. The openings on the enclosure are for air convection. Do not allow overheat. DO

NOT COVER THE OPENINGS. Leave at least 5cm of space at the sides for its
correct ventilation. 

7. Never  open  the  equipment.  For  safety  reasons,  the  equipment  should  only  be
opened by qualified personnel. 

8. The equipment must be plugged into a grounded outlet. 
9. Pay  attention  to  connection  polarity  when  operating  the  machine  with  a  power

supply (DC). Reverse connection polarity may cause damage to the equipment, or
to the power supply.

10.Let staff check the equipment if any of these situations occur: 
a) The power cord or power plug is damaged. 
b) Liquid has penetrated inside the equipment. 
c) The equipment has been exposed to moisture. 
d) The equipment does not work well or does not work according to the instruction
manual. 
e) The equipment was dropped and damaged. 
f) If the equipment has obvious signs of damage. 

11. Cabling must be done only by trained personnel. Disconnect the audio inputs and
outputs  while  making  connections or  disconnect  the  equipment  from the power
supply. Be sure to use the proper cables to make the connections.
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 1  INTRODUCTION

NEO Control  is an auto-install  application without  a database that  allows to easily
control and supervise any NEO system by a remote and secure access.

Instructions  and  pictures  at  this  user's  manual  belongs  to  software  version  NEO
Control v1.0.3.0.

CHARACTERISTICS: 

• Easy to install and configure. 

• Sources routing control. 

• Sources and zones volume control. 

• Total system supervision (failures, evacuation mode, etc.) by zones. 

• It allows to add installation drawing plans. 

• Synchronized with NEO System. 

• Exclusive for NEO Systems (NEO 8060 and NEO Extension units). 

• One NEO system can accept up to 5 connections from NEO Control. 

• NEO Control allows to control just one NEO 8060 + NEO Extensions. It does not
allow to control multiple NEO systems. .

 2  INSTALL AND LICENSE

 2.1  Install

After executing the installer, a screen appears to select the language.

The language chosen during the installation will fix the language in which NEO Control
will run for the first time (it can be modified later in Preferences). 

After choosing the language, the conditions of the installation must be accepted, and
after that, the installation folder should be selected:
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Picture 1: Language selection



Finally, you can choose the options of creating a shortcut on the desktop and opening 
NEO Control right after the installation is finished.

 2.2  License

In order to use NEO Control, it is necessary to obtain a license. There are two types of
license:

• Temporal license: A free license for a maximum of 30 days.

• Permanent  license: to  be purchase to  the  Manufacturer  (LDA)  or  Authorized
Distributor. 

The license process starts when NEO Control  is installed. During this process the
following codes will be used: 

• Installation Code: 20 characters code (numbers and letters) which is different for
each PC where NEO Control  is  installed.  The license of  NEO Control  will  be
always associated to this installation code, so it will not be possible to use the
same license in a different PC. This code is generated according to the hardware
of the PC, so if any part of it is changed (hard disk, processor, network card ...),
the code will be different, so it will be necessary to re-license NEO Control. . 

• Serial  Number (License Key):  14 digits  key (just  numbers)  obtained when a
complete license for NEO Control is purchased. 

• License Code (Activation Code): 16 characters code (numbers and letters) that
allows to activate NEO Control and start to use it.  

When NEO Control is executed for the first time, the screen to validate the license is
shown. To get the License Code (Activation Code), it is necessary to visit the webpage:

http://license.lda-audiotech.com 
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Picture 2: Installation screen

http://license.lda-audiotech.com/
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If you click on the “Get License” button in this window, the web browser will be opened
automatically and the installation code will be automatically typed.

Once access to the web platform the following star up screen appears. Fulfil the fields
Installation  Code ans  eMail  address  and  select  the  button  to  get  register  with  a
Temporary Activation Code or Perpetual Activation Code:

The eMail will be necessary to contact with technical support and get the software
activation recovery code.
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Picture 4: License activation web app

Picture 3: Validate and license acquisition screen



 2.3  Temporary License

Temporary license allows to use the software without the need of having acquired it for
a term of grace. Once this period finish, the software stops to works normally. Only an
unique temporal license per computer is allowed. If you want to continue using it, you will
have to acquire it in perpetuity. 

After this selection, on Get Temporary Activation Code choose, reCaptcha validation is
need:

This will be accepted and proceed on Get Temprary License, what responds with the
Activation Code, adding some data information:

Temporary License is compose by :
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Picture 5: Temporary License Activation web app

 
Picture 6: Temporary License Activation example
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• Activation Code: This will be introduced at the installed software due to use it
with no restriction.

• Creation date: Register or creation date of the Activation Code. 

• Expiry date: It is the date of validity of the license, once passed the date, the
software will stop working.

• Number of Days: Validity resting time, on days.

 2.4  Perpetual License

A Perpetual License  allows the use of the software for life-time, without any time or
feature restriction. It will appear after click on Get Perpetual Activation Code button with
the License Key field and reCaptcha fulfilled.

5

Picture 7: Perpetual License Activation web app

Picture 8: Perpetual License Activation example code



• Activation Code: This code should be used to get the main software with a 
Perpetual Licence activation validated. 

Once obtained the Activation Code, kindly introduce it on NEO Control, due to start
and work with it.

 2.5  Version update

NEO Control can be updated to a new version without licensing the software again
and without losing the current configuration. In order to do that, it is necessary to follow
these steps: 

1. Run the installer for the new NEO Control version without uninstalling the previous
version. 

2. The installer will detect the old version and it will propose to uninstall it. Click on
the “Yes” button. 

3. The installer  will  remove the old version  automatically  and will  install  the new
version preserving the license and all the configuration parameters. 

6

NOTES: In case of NEO Control software were uninstall and then install again, it
will be necessary to repeat the same license process: The License Key and the
Activation Code will be the same; so it wouldn't be necessary to acquire another
new License Key. 

If you forget the Activation Code, it may be obtained again at the web application
http://license.lda-audiotech.com, just introducing the original License Key. 

http://license.lda-audiotech.com/
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 3  NEO CONTROL CONFIGURATION (EDITION MODE)

To enter into  Edition Mode, you have to press simultaneously  Alt + Shift + C. After
finishing the configuration, you can return to the normal Operator Mode by pressing the
same combination of keys again.

After  executing NEO Control  for  the first  time and entering the Edition Mode,  the
following User Interface appears:

Picture 9: Edition mode graphic interface

 3.1  User Interface general description

In the Edition Mode screen the following areas are shown:

(a) MENU BAR

In the upper part of the window. It shows the general options of NEO Control: “File”,
“View”, “Tools” and “Help.

(b) “ZONE VOLUME” TOOLBAR

Under the menu bar. It shows the buttons: “Volume Up” “Volume Down”, “Mute” and
“Unmute”.
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(c) “ZONE MAPS” TOOLBAR

Under the “Zone Volume” toolbar. It contains the following buttons: “New Map”, “Edit
Map”, “Delete Map”, “Add Zones”, “Remove Zones”, “Select All” and “Unselect All”.

(d) MONITORING PANEL

It contains a status log that allows to monitor the system with text logs and the 4 light
indicators on the right side:

• DIS:  When it  is yellow, it indicates that there is a disabled zone. If  no zone is
disabled, the colour of the indicator is grey, as if it were turned off.

• FLT: When it is yellow, it indicates any error or fault in the system.

• EMG: When it is red, it indicates that the system is in Emergency State.

• LINK:  When it  is green, it  indicates that the connection to the NEO system is
active (online).

In addition to the User Interface displayed by default in Picture 9, in the “View” menu 
you can select up to 3 additional panels: "Events", "Sources" and "Zones" (see section
3.3). This way, the user interface would be as shown in Picture 10.
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Picture 10: Edition Mode with all panel deployed
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(e) EVENTS, SOURCES AND ZONES PANELS

To the left  of  “Zone Maps”,  these 3 panels appear  grouped in 3 different  tabs by
default. 

The monitoring panel is always fixed and visible in the lower part of the window, both
in Edition Mode and in Operator Mode. 

The Menu bar hides automatically when the user exits the Edition Mode (by pressing
Alt+Shift+C)..

The  “Zones  Volume”  toolbar  can  be  shown  or  hidden  from  the  NEO  Control
Preferences (see section 3.4).

The  four  central  panels  (“Sources”,  “Events”,  “Zones”  and  “Zone  Maps”)  can  be
customized (see section 3.3).

 3.2  Connect to a NEO System

Press on “Tools”, and then on “Device Discover”. The following window is opened:

This window shows a list of all the NEO systems connected on the same network.
You need  to  select  the  system  you  want  to  connect  and  then  click  on  the  button
"Connect".  When  the  State  LED  becomes  green,  the  system  will  be  successfully
connected.

 3.3  Central panels customization

The central panels (“Sources”, “Events”, “Zones” and “Zone Map”) can be shown or
hidden, selecting the corresponding option in the “View” menu.
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Picture 11: Device discover

NOTE: The button “Locate” makes all the physical LEDs in the selected system to blink
for some moments. This helps to properly identify each physical system..



By default, these panels appear pinned. They can also be unpinned by clicking on the
“pin” button, so each panel is minimized on the right side of the screen.

It is also possible to change the panels position, so that they are displayed side by
side in different disposition (vertical or horizontal) or grouped in tabs.

In order to do this, you have to click on the title of the panel and drag it until the
following widget appears :
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Picture 12: View menu

Picture 13: Relocating Source, Events and Zones panels
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Then,  you can  drag the  panel  to  the  different  zones of  the widget in  order  to
reposition the panel where desired.

It is also possible to modify the size of each panel by clicking and dragging on the
edges of the panel.

 3.3.1  Events panel configuration

The “Events” panel shows a list of all the events programmed in the system what are
activated through UDP commands

In Edition Mode, the "Show" column appears allowing to select which trigger should
be shown in Operator Mode. 
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Picture 14: Panels repositioning widget



All these events must have been previously programmed with NEO Configurator. The
list of events of NEO Control will be all UDP command triggers that have been configured
using NEO Configurator.

 3.4  Preferences

From “Tools” menu, the user can access to the NEO Control  Preferences with the
following options:

• Language:  Changes the language of the User Interface (but not the names of
zones, sources or events which are already configured in the NEO system; these
names can be edited manually with NEO Configurator).

• Enable zone volume controls:  Hide or show the "Zone Volume" toolbar  that
appears above the panels:

• Enable source volume controls: Hide or show the volume and mute buttons that
appear within the "Sources" panel:
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Picture 15: Events panel, Edition Mode

Picture 16: Preferences
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• Full screen mode: In this mode, NEO Control will enter full screen, hiding the
NEO Control title bar and the Windows taskbar.

 3.5  Add map

In order to add a new map, you should follow these steps within the Map Zones menu:
1. Press on “New Map” button.
2. A new window will open where we will define the properties of the map that we are

going to create.

3. In the button “Open” in the “Background Image” section, you will be able to select 
an image from your computer to use as background (like a map or drawing). 

4. The style of the background image can be changed:

• Size: Indicates the size of the map in pixels. It can be different from the
background image. The minimum dimensions of the map should be 400 x
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Picture 17: New map properties screen



300 pixels. 

• Button “Background image size”: It automatically changes the size of
the map to the same pixels of the Background Image. 

• Layout: If the image size and the map size are different, the layout type
will define how the image will be adjusted to the map:

◦ None: The image will appear in the upper left corner without changing
its original size. 

◦ Tile: The image will be displayed in its original size repeated several
times until it occupies the entire map. 

◦ Center: The image will appear centred on the map with original size. 

◦ Stretch: The image will be fully shown and adjusted to the dimensions
of the map, modifying its aspect ratio to occupy all the available space. 

◦ Zoom:  The  image  will  be  fully  shown  and  will  occupy  the  largest
possible area of the map without modifying its aspect ratio.

• Back Color: The color that will be shown in the empty spaces of the map
(where it is not covered by the Background Image). 

• Grid: Optionally you can create a grid with the style, color and distance
between selected points.

◦ View grid: It shows the grid over the background image. 

◦ Snap to grid: It forces the zone buttons to be positioned at each point
of the grid, even if the grid is not shown.

5. After creating the map, zones can be added as explained in the section 3.6.

 3.6  Add or remove zones to a map

In order to add zones to a map, first of all it is necessary to show the “Zones” panel
(see section 3.3). After that, we can proceed with the following steps:

1. Select in the “Zones” panel those zones that you want to add to a map (see

14

Picture 18: Zone Map



User's manual: NEO Control

section. To select more than one zone, press and hold “Ctrl” key meanwhile the
selection.

2. Click on the map tab where you want to add the zones.
3. Click on the button “Add Zones” of the “Zone Map” panel. 
4. All the selected zones will be added as buttons in the upper left corner of the map.
5. The zone buttons can be relocated on the map. You just need to drag and drop

each button to the desired position:

6. The size of the zone buttons may be adapted by clicking with the secondary
button on the zone button:

7. To remove one or more zones of the map, you have to select them and press
the button “Remove Zones”. 
The selected zones will be marked with a blue background. The zones that are 

not selected will have a white background. 

 3.7  Save, load and create new projects

These actions (save, load and create new projects) are mode from the “File” menu:
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Picture 19: Map with several position zones locations example

Picture 20: Size of the zone indicator



Trough these options you can:

• “Save” the NEO Control project in a file with the extension “.nct” 

• “Open” a saved project. 

• “Create” a new project . 
In the file with “.nct” extension the following parameters are saved:

• IP address of the NEO Master linked in the project.

• NEO Control preferences.

• Custom position of the panels “Sources”, “Events”, “Zones” and “Zone Maps”.

• Configuration of all the Zone Maps, including the background images.

 4  NEO CONTROL USE (OPERATOR MODE)

 4.1  User Interface general description

Each  time  NEO Control  is  initiated,  the  Operator  Mode  User  Interface  is  shown.
Depending on how it was configured in the Edition Mode, more or less panels will appear
in different positions.

After running NEO Control for the first time, the following User Interface is shown:
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Picture 21: File menu
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To describe all the possible options, we will assume that all the NEO Control panels
have been activated: "Events", "Sources", "Zones" and "Zone Maps" (see on Picture 23).
In the Operator Mode screen, the following areas are shown:

(a) “ZONE VOLUME” TOOLBAR

It  shows  the  buttons:  “Volume  Up”  “Volume  Down”,  “Mute”  and  “Unmute”.  These
actions will be applied to the selected zones in the “Zones” panel or in the “Zones Map”
(see section  4.2 ). To set more than one zone at the same time, press and hold  “Ctrl”
key meantime the selection.

(b) “EVENTS” PANEL

It shows the programmed events list in the system activated by UDP commands (see
section  4.4 ).

(c) “SOURCES” PANEL

It shows all the audio sources configured in the system and (optionally) some buttons
to manage its routing and volume levels (see section  4.3 ).

(d) “ZONES” PANEL

It shows all the zones configured in the system and their most important parameters,
such as the sources routed in each zone, their zone volume, state, etc.

(e) “ZONE MAPS” PANEL

It contains one or more maps that graphically represent the zones of the NEO
system. Includes the "Select All" and "Unselect All" buttons.
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Picture 22: User interface in Operation Mode



(f) MONITORING PANEL

Fix at the lower panel. It contains a status log that allows to monitor the system with
text logs and the 4 light indicators on the right side:

• DIS:  When it  is yellow, it indicates that there is a disabled zone. If  no zone is
disabled, the color of the indicator is grey, as if it were turned off. 

• FLT: When it is yellow, it indicates any error or fault in the system. 

• EMG: When it is red, it indicates that the system is in Emergency State. 

• LINK:  When it  is green, it  indicates that the connection to the NEO system is
active (online).

 4.2  Selecting a group of zones

A group of zones can be selected from the “Zones” panel or from a “Zone Map”.
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Picture 23: User Interface in Operator Mode with every panel deployed

NOTE: The monitoring panel is always fixed and visible in the lower part of the window. All
the other panels and toolbars are customizable, so they could appear in different positions
or not even be shown.
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There are two ways of selecting a group zones from the “Zones” panel:
1. Using the keys Ctrl or Shift of the keyboard while clicking on different zones (as in

Windows Explorer). 
2. Click on one zone and drag up or down to select consecutive zones.
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Picture 24: Zones panel

Picture 25: Zone Map in Operator Mode



To select many zones from a Zone Map, it is necessary to keep pressed the Ctrl key
while clicking on the zones with the mouse.

 4.3  Route, unroute and change source volumes

The “Sources” panel shows all  the audio sources configured in  the  system and
different buttons to manage the routing and volume levels. 

• “Route Source”  button:  It  routes the selected source to the zone or group of
zones selected in the “Zone” panel or in the “Zone Map” (see section 4.2). 

• “Unroute  Source”  button:  It  unroutes  any  source from the zone  or  group of
zones selected. This way, those zones becomes to get “Source 0” routed.

• “Volume Up” and “Volume Down” buttons: They change the volume levels of the
selected sources.

• “Mute” and “Unmute” buttons: They mute (silence) or unmute (activate the 
sound) of the selected sources. 

• “Routed Zones” button: When this button is pressed, all the zones with the 
selected source routed will blink for a few seconds.

 4.4  Launch events

The “Events” panel displays the programmed events list at the device, whom launch
they via UDP command.
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Picture 26: Sources panel

NOTE: To unroute a source, it does not matter if a source was previously routed or not
at the Source panel. NEO Control will unroute anyway that source at the zone group
selection.
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These events can launch any kind of automated actions to control the system. You just
need to select it from the list and click on “Send Command”.

Types of possible actions: 

• Play pre-recorded messages. 

• Activate zones volume or sources presets. 

• Activate source routing presets. 

• Start an emergency with preconfigured evacuation sequences. 

• Activate or deactivate GPIOs or 24V override outputs. 

• Send commands via Serial Port RS485. 

• Send UDP commands via Ethernet.
All these events must have been previously programmed with NEO Configurator. The

list  of  events  of  NEO  Control  will  be  all  UDP  command  triggers that  have  been
configured using NEO Configurator.
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Picture 27: Events panel in Operator Mode
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